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How to Make Best Use of the Manuals

When you open the box

4

P—
Printed Manual

CanoScan D1230U/D2400U
Quick Start Guide

software installation to scanning and

using the scanner for the first time.

Describes operating procedure from set up and

confirmation of operation. Please read before

Electronic Manual

) 4

Electronic Manual CanoScan Toolbox
User's Guide

Detailed information on how to use
CanoScan Toolbox.

AEACIIGVENTED CanoScan D1230U/D2400U

Product Guide

Describes handling and care of the scanner,
and introduces the accompanying software
programs.

Canon Plug-in Module CS-U
\___—  User's Guide
Detailed information on how to use
Canon Plug-in Module CS-U.

After you have read this book and mastered
the use of Canon Plug-in Module CS-U and

CanoScan Toolbox...

Manual for Each
Application Software

Tells you how to use Adobe Photoshop LE and
ScanSoft OmniPage SE.

When using the
accompanying
application
software.



How to Use this Guide

This guide explains the operating procedures for Canon Plug-in Module CS-U
(hereafter referred to as Plug-in Module CS-U), the Macintosh driver (plug-in
software) used with Canon image scanners.

A plug-in is not an independent software program; it must be used within a plug-in
compliant application, such as CanoScan Toolbox or Adobe Photoshop LE, to
expand the capabilities of that program. Adding scanning capabilities to your
computer is as easy as putting in a plug. Simply copy the Plug-in Module CS-U files
to your computer.

Please read this guide to perform the installation procedures and scan. Store this
manual in a handy location for future reference.

Where to Look

Quick Start Instructions =% p. 70

The Quick Start Instructions provide a brief summary of commands and
procedures that will assist in using Plug-in Module CS-U immediately.

Scanning Preparations (Required Reading) —» p. 13

All users should read this section. This section describes the procedures and
settings required before scanning, including positioning the original and
selecting the output device, resolution, magnification and scanning mode.

Scanning (Required Reading) —» p. 29

All users should read this section to learn the procedures for scanning images
and saving scanned images.

Adjusting Scanned Images —» p. 35

Read this section for details about how to adjust image brightness, color
balance and other attributes. You can read this section as required.

Appendices

Read this section for troubleshooting tips, glossary terms and the index.

About the Conventions Used in this Guide

The following conventions are used in this guide to draw your attention to
important information.

Ve Caution:
( Q This symbol is used to highlight procedural precautions and limitations.

Always read these topics to avoid errors.

Hint:

@ This symbol is used to present helpful hints and supplemental information.
Reading these topics is recommended to enhance your enjoyment of
Plug-in Module CS-U.



Table of Contents

How to Make Best Use of the Manuals ...........ccccooiiiiiiiiii 2
HOW 10 Use this GUIAE ..o 3
Table Of CONTENTS ... .eii e 4
Installing Plug-in Module CS-U ..o 6
CoNtrol Panel FEATUIES ... ...iiiiiii e 7
SCANNING PrOCEAUIES ...t 8
Plug-in Module CS-U Special Features .........ccc.ooiiiiiiiiiiieiiee e, 9
Quick Start INStrUCLIONS .......coiiiieecciiireee i reessa e ss s e e s s s e e e e nnnasas 10
STEP 1
Scanning Preparations..........ccccceirvinniiisnssssssssssnn 13
Displaying the Plug-in Module CS-U Control Panel .............cccccciiviiiiiiiiiiiii 14
POSIIONING OFIGINAIS ...t 16
PIEVIEWING ..ottt 17
Selecting the OULPUL DEVICE .....coouiiiiii e 18
Setting the Resolution and Magnification ............ccccoiiiiiiiiiii 19
Setting the SCaN MOGE .....oiiiiiiiie e 21
Verifying the Image before SCanning.........cccccooiiiiiiiiiiiii e, 23
Rotating the IMage ......ooiiiiie e 24
Setting Prefe@réNCeS ... ..o 25
OULPUL DBVICE ...t 25
ASPECT RATIO ... 25
g USSP 26
PrevieW WINAOW ...t 26
Reset Default SETtNGS ....ooviiii i 27
STEP 2
1Y o= 010 T ' 29
Setting the SCAN Aa ....eiii e 30
p4o o 10111 Te E PRSP SPPPRRPTUPPPR 31
SCANMNING 1.ttt ettt e e e e 33
SaVING SCANNEA IMAGES .....ooiiiiieeiie e 34
SCANNING FIM oo e 35
Remove Dust and Scratches(CanoScan D2400U only) ........cccoooiiiiiiiiiiiiice 38



STEP 3

Adjusting Scanned IMages ..........ccocerirreiricrcnrrissse e 39
TONE AQJUSTMENT ..ot 40
HIStOGram SETHNGS ... .eie et 41
TONE CUMNVE SETHINGS ..eeiiiiiiiie et e e e e 44
Brightness and Contrast SETtiNGS .........oooiiiiiiiiiie e 47
Adjusting the Color BalanCe ..........coouiiiiiiii e, 49
GammMa Value SETHINGS ... 50
Adjusting the Threshold Value ..., 52
AULO TONE COMECTION ..ottt 53
UNSNAMD MASK ... 54
DIBSCIEEIN ..ttt 55
High-speed SCan MO .......coviiiiii i 56
Saving/ReCalliNng SEtHINGS ....cueiiiiii e 57
SCANNING TECANIGUES ..o 59

/Y o o 1= T [T PPPPPPPP 1

TrOUBIESNOOTING ..o 61
ErrOr IMBSSAES ...ttt 65
GlOSSAMY et 66
X e 71
Canon Customer Support Help DesK ........oooiiiiiiiiiiiiiiee e 73

No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into
any language in any form by any means without the prior written permission of Canon Inc.

Canon Inc. makes no warranties for damages resulting from corrupted or lost data due to the operation or
malfunction of hardware and software.

While every effort has been made to ensure that the information contained in this guide is accurate and complete,
no liability can be accepted for any errors or omissions. Canon Inc. reserves the right to change the specifications
of the hardware and software described within this guide at any time without prior notice.

Please take note that international copyright laws prohibit the scanning of copyright-protected materials for any
uses other than for personal use.

CanoScan and Canon Plug-in Module are trademarks of Canon Inc.

Macintosh, Power Macintosh, Mac OS and ColorSync are trademarks of Apple Computer, Inc., registered in the
U.S. and other countries.
iMac is a trademark of Apple Computer, Inc.

Adobe® and Photoshop® are trademarks of Adobe Systems Incorporated.

Other names and products are trademarks or registered trademarks of their respective companies.



Installing Plug-in Module CS-U

Please install Plug-in Module CS-U with the other application programs
according to the instructions in the “Install the Software"” section of
"Using the Macintosh Platform” of the Quick Start Guide supplied with
the scanner.

Operating Environment

Hardware
e Power Macintosh, iMac, PowerBook or iBook with built-in USB ports
(performance on Macintosh compatibles is not guaranteed)

Main Memory
® 32 MB or more (64 MB or more recommended)

Application Software

e CanoScan Toolbox
¢ Adobe Photoshop LE
e Other plug-in compatible application programs

Display

® 32,000 colors or more

System Software
* Mac0S$ 8.5-9

Ve Caution
( g ¢ The ColorSync™ Profiles file is installed along with Plug-in Module CS-U.
ColorSync™ Ver. 2.0 or higher is required to use these profiles with the

automatic color matching system (p. 49).



Control Panel Features

When you need more information about a control panel button or menu, refer to

the illustration below and go to the referenced page number for more details.

¢ The illustration may differ slightly from the version of Plug-in Module CS-U
provided in your package.

Preferenc:es

+ Recommended Qutput Device... _
ColorSync :I p. 53 Aspect Ratio... pp- 25-28
None Unit...
Tone adjustment... p- 40-52 Preview Window...
Descreen p- 55 Shut off lamp time... Film
+ Unsharp Mask p- 54 Resets Default 5ettings...
High-speed Scan Mode |[] p. 56 SR I SR S Available whin [Film] is
— .
—rr ' Ll selected in the Preferences
Setting File Film
52 menu. | p. 35
ez |
Close Box — RGB values
p. 14 p- 14
Scan Mode
p. 21 1l =——————Canon plug-in module G-U4I=———F———H
output Device Settinlj File Imége Preferences Film | Ri119/194 G:@?1/15@ B:aaafaaal
p- 18 |l scan Mode: (B2 24bit Color [~)
Resolution
pp. 19-20 |L{}-Output Device: [ CRT(72dpi) [~]
Magnification Resolution: [ AE i
pp. 19-20 —I—--Magnification: E%
Image Size — )
pp. 19-20 Image Size: | 241 * 340 |p>< |
Required/ —Required/Free: | 246 / 2,095,992 | kb
Free memory
p. 21 alafay (@l = | &
ZOOI’T\BR:tset — O Q | G | ! | T}’l Preview Scan
on T
up 32 Canon Plug-in module CS-1|4.1
Z | . .
gz::o: Preview Window [ p. 74, 26 —
p. 31 .— Scan Button || p. 33
R°tat2i‘2" Button —— Preview Button (| p. 17
Zofr.n Out Button Browser Button (] p. 23
p. 32 ——— Auto Tone Adjustment Button | p. 40

Tone Adjustment Button [ | pp. 40-52

: Hint
@ In this guide, menu items are marked in the following manner:

Setting File

=9 Select [Load] from the [Setting File] menu.




Scanning Procedures

Follow these procedures to use Plug-in Module CS-U.

Is Plug-in Module CS-U installed?
Refer to the scanner's

SO D
— Quick Start Guide to
¥ 4 install it.

Is the scanner attached?
Refer to the scanner's

DO D
— Quick Start Guide to
- 4 attach it.

STEP 1

Prepare for Scanning 0 p. 13
Position the Original p. 16
Preview p. 17
Select the Output Device p. 18
Set the Resolution and Magnification p. 79
Set the Scan Mode p. 21

4

Verify the Image before Scanning
(Browser Window) O p. 23 STEP 3

Adjust and Edit Scanned Images

4 0 p.39
Are the Brightness and Color Satisfactory? Histogram p. 41
@ @ Tone Curve p. 44
Brightness and Contrast p. 47
— Color Balance p. 49
* 4 Gamma Value p. 50
Threshold Value p. 52
Auto Tone (ColorSync™) p. 53
STEP 2 Unsharp Mask p. 54
Scan O p. 29 Descreen p. 55
Set the Scan Area p. 30 High-Speed Scan Mode p. 56
Zoom p. 31
Scan p. 33 If the current brightness
Save Scanned Images p. 34 and color pose no problem,
Scan Film p. 35 there is no need to adjust

these settings.



Plug-in Module CS-U Special Features

* See the Results of Adjustments Immediately (Dynamic Preview)

Once in preview mode, the results of adjustments to scan mode settings and colors
are promptly reflected in the preview image.

Highly detailed adjustments can be performed easily because you can see the
results of your changes as they are executed.

* ColorSync™ (Ver 2.0 +) Compatible for Auto Tone Correction

Compatible with the Mac OS 8.5 ColorSync™ (Ver 2.0 +) color management
software. This function automatically matches the color profiles of various devices,
such as scanners, color displays and color printers, for optimal color reproduction.

* Browser Function Permits Confirmation of the Real Image

Before Scanning
The Browser function lets you check the image to be scanned in detail before
commencing the scan. This function presents a much higher quality image than the
preview function.

* Histogram Function Realizes Beautiful Contrast

Simple operation allows you to achieve beautiful contrast with half-tone
gradations.

* Gamma Curve Adjusts Image Brightness

The Gamma Curve feature provides four methods you can use to refine in detail
the level of image brightness until you are satisfied with the results.

* Works within Image Processing Software
for Easy Image Editing

Plug-in Module CS-U can be used to extend the functions of plug-in compatible
image processing application programs.

* Supports Optional Film Adapter Unit
Scans 35 mm, 120 format and 4x5 films when the optional Film Adapter Unit
FAU-512/513 is attached. Just select the negative or positive film setting and set
the film size to effortlessly create color prints with the auto brightness and tone
adjustment features.



Quick Start Instructions

Follow the procedures below to start scanning immediately. If you require more
information at any stage, read the pages referenced at each step.

ol

Neam?®

Install Plug-in Module CS-U

This step is not required if you have already installed Plug-in
Module CS-U following the instructions in the Quick Start
Guide.

1. Place the CanoScan Setup Utility CD-ROM into the
computer's CD-ROM drive. The CanoScan Setup Utility will
start automatically. (If it doesn't, double click the [CD-ROM]
icon, followed by the [setup] icon.)

2. Click [Install the Software] to install Plug-in Module CS-U and
the other application programs.

Start Plug-in Module CS-U =¥ p. 14

1. Start Adobe Photoshop LE or other plug-in compatible
application.

2. Open the [File] menu, select [Acquire] and [CanonPI CS-U
4.1.0..].

Position materials for scanning and preview them.
> p. 16

1. Position an item on the document glass (platen).

2. Click the Preview button.

¢ The entire scanable area of the document glass will be
previewed and displayed in the preview window.

[0 =——————Canonplug-inmodule (§-U41=—————H
Setting File Image Preferences Film

Scan Mode: | B9 24bit Color -

Output Device: | CRT(72dpi) -]
Resolution @:' E dpi

Magnification; E%
[SYEYEY =
DB B )‘I Preview

Canon Plug=in module C8-U 4.1

i
Soan

,,,,,,,,,,,,,,,,,,,,,

______________o______________



i Set the Scan Mode, Output Device, Resolution and
Magnification —» pp. 18-22
¢ Scanning mode determines how the image is scanned (p. 217).

¢ Output device setting optimizes the images for particular uses (p. 18).
¢ Resolution determines the amount of detail in the scanned image

(. 19).

¢ Magnification determines the amount of enlargement or reduction
of the output image display (p. 79).
- Verify Image Quality with the Browser Function before
Scanning ~¥ p. 23

1. Click on the [Browser] button.
* The selection frame will appear.

’/ N
"=

[

[Selling File  Image  Preferences  filn

Scon Hode: | B8 24bit Color -

Resolution: ‘== "73[Fom

Hagnifi cation: 16 [E®
image Stze: [ Sese 799 e
Requires/Frae: [ 137 20080 |mo
'— =
Aafa] gla
EDD (S |

Caren Flugrin sesbale CE-U 4.1

2. Move the selection frame to specify the area of the image
you want verified and click the mouse button.
¢ Plug-in Module CS-U will read the image and display the

browser image.
3. After you have examined the browser image, click the mouse

anywhere.

Specify the Area of the Image to be Scanned ~% p. 30

Select the area to be scanned by clicking and dragging the

mouse pointer over the image.

¢ You may find it convenient to use the zoom feature to select
small areas or to select specific scan areas with precision (p. 317).

[a] 2 i module (-1 41 E|
Setling File  image  Preferences il

Scon Hode: | 9 24bit Cobor -

Resolution: ‘== "3 {5 an1

Hagnification: ,T._Ez
RequireafFres: [ 7747 7095092 kb
SIENEY =
[E]D[] [=]ir] | pravien

Caren Flug-in mabile G- 4.1

sl /J
v

(

&l
B




/w Scan the Image —¥ p. 33
Click on the [Scan] button.
T e Plug-in Module CS-U will scan the image.

dube (S-U 4.1 B

5]
Selting File Image  Preferences  Fin

Scan Hode: [ 240iK Color -
Resolution: ‘G "73[Hom
Hagrifi cation: EE‘

image Stze: [ 250+ S04 o
Requirad/Froe: '=~
PR EV I E] g' d_‘ s
[EI20 (L |
A 3

Caren Flug-in mokile CE-U 4.1

h—-—"

¢ \When the scan is complete, close the Plug-in Module CS-U
control panel. The scanned image will appear in the Adobe
Photoshop LE or other plug-in compatible application
window as an “Untitled” file.

titled-1 @ 100% (RGB) — I &

Progress

Import: Canon PI (5-U4.1 9

ST

| 1oos [ DociZ7aK/ETIK B[4 ID

Save the Scanned Image —% p. 34

/—
‘ BJ Save the image with Adobe Photoshop LE or other plug-in
N compatible application, specifying a folder and file name.

When the amount of light of the lamp inside the scanner is insufficient, the
message “Now adjusting lamp..."” may be displayed. Wait as is, until the
amount of light increases enough.



Scanning Preparations

Step 1 presents the essential preparations for scanning.
The following procedures are explained on the indicated pages.

Displaying the Plug-in Module CS-U Control Panel =¥ p. 14

v

Positioning Originals =* p. 16
v

Previewing =¥ p. 17
v

Selecting the Output Device =? p. 18
Setting the Resolution and Magnification =» p. 19
Setting the Scan Mode = p. 21

v
Verifying the Image Before Scanning =¥ p. 23
Rotating the Image =¥ p. 24
Setting Preferences =* p. 25



STEP 1

Displaying the Plug-in Module CS-U Control Panel

The Plug-in Module CS-U control panel is used to perform scans. Plug-in Module
CS-U can be opened from CanoScan Toolbox or Adobe Photoshop LE and other
plug-in compatible application programs.

To quit Plug-in Module CS-U, click on the close box at the top left of the control
panel.

Adjusts the settings for the scanning job such as the scan mode,
output device, resolution and magnification.

Close Box
Quits Plug-in Module CS-U.
RGB Values
Menu Bar Displays the R, G,and B values at the
Click on any menu item to display current cursor position (pre-adjusted
more options in a pull-down menu. value/post-adjusted value)
' |
[
UEl %Camn plug=in module 5= 4.1 =
S'etting File Image Preferences Film lF!:255.-"’255 GiZ55/255 Bi255/255
Scan Mode: [E 24bit Color |L] 1.
Output Device: [ CRT{72dpi}) |L] ) i

Resolution: @:I' @ dpi
Magnification: @%

Image Size:

o Fequired/Free:

12/ 20959 |mb

2 | =
OlQlGI El Preview Sean e ______. .

Canon Plug-in module CS-U 4.1

Buttons
Click the appropriate button to zoom, rotate or browse the image
or correct colors, adjust the histogram or start the preview or scan.

1
1
1
f
554 * 750 | px
1
1
1
1

The image size and disk size that were Preview Window
specified in the preview window are Displays the image in preview mode. ——
automatically displayed here.




S TEP

1

Operating Procedures
The following provides an example of scanning from within Adobe Photoshop LE.

i’

p
p

Verify that the scanner is attached to your computer and that the power

is on.

Read the Getting Started guide for instructions on how to connect the scanner.

Start Adobe Photoshop LE.

Select Plug-in Module CS-U from within Adobe Photoshop LE.

Open the [File] menu, select [Import] and [CanonPl CS-U 4.1.0...].

The Plug-in Module CS-U control panel will display.

mEdit Image Laver Select Filter Yiew

New... 38BN
Open... ®0
Close W
Save S
Save As... i3S
Save a Copy.. =3#®S
Revert

Import
Export »

Page Setup.. GEP
Print... ®P

CanonPl C5-U4.1.0.. |

PICT Resource...
Twain Acquire...
Twain Select...

Preferences >

Adobe Online...

Quit #Q

Caution
¢ Plug-in Module CS-U is not a stand-alone application program. It must be

o

dube (5-U 4.1

Selling File _Image  Preferences |l

R e o

Scan Hode: | 9 24bit Cobor -

Resolution: ‘=== ""73[Hom

(i
RequiredsFrae: [ 12730959 |mo
] b ﬂ
[SI[™] [ ]| recie

Cares Flug-in madibe CE-40 4.1

Hagnification:

&l
Boan

started from a plug-in compatible application program, such as CanoScan

Toolbox or Adobe Photoshop LE.

* The size of the Plug-in Module CS-U control panel will vary according to
the resolution of the computer display.

¢ The size of the control panel can be adjusted with the [Preview

Window...] option in the [Preferences] menu (p. 26).



STEP 1

Positioning Originals

Place the original you intend to scan on the scanner's document glass (platen).

Procedures

Place the original on the scanner's document glass.

Open the cover and set the original face down on the scanner’s document glass
with the top edge at the back of the scanner. Align the original’s corner with the
alignment mark.

Alignment Mark

p Close the cover carefully so the original does not shift out of position.

Caution
( g ¢ Be careful not to dirty the document glass when placing items on it.
e If an original has distinct horizontal or vertical lines, you should try to

position it on the document glass as squarely as possible to have the lines
appear straight.

¢ The maximum scanable size is the area of the entire document glass.

e Straighten out curls or folds in originals before placing them on the
document glass.

¢ To scan right to the edges of an item, position it approximately 3 mm
away from the edges of the document glass (platen).



STEP 1

Previewing

=l

Freview

The preview scan is a trial scan performed before the final scan that encompasses
the entire scanable area of the document glass. The preview image is shown in the
preview window. Use this image to specify a scan area and adjust the scan settings
for the image.

Operating Procedures

Click on the [Preview] button.
e The image will be scanned and appear in the preview window.

D =————————(Canonh plug-in module -4 aaarrriae0s———————— E
Setting File Image Preferences Film

Scan Mode: |3 24bit Color v|
Output Device: | CRT(72dpi) [~]

Resolution: @Z. Edpi
Magnificatian: [ rodF]=

Image Size: 565 * 700 px
Required/Free: 1.3 / 2,0050 o

— -
afala @ = | &
OIQIG Preview | 4Scan

._’

Canon Plug-in moduly C5-04.1
‘\/

U

Hint

¢ To change the size of the preview window, use the [Window Size] settings
in the Preview Window Settings dialog (p. 26).

¢ The Dynamic Preview function enables changes to settings, such as the
scan mode and brightness, to be immediately reflected in the preview
image.

Caution
(@ ¢ The preview image provides only an approximation of the scan and the
final results may differ to some degree from it.
e Calibration automatically starts when [Preview] or [Scan] button is clicked.



STEP 1

Selecting the Output Device

Use the following procedures to select the output device (printer, etc.) for the
scanned image. Select the device that corresponds best to your output device and
use of the image.

Operating Procedures

Click the arrow on the [Output Device] section of the control panel and
select a device from the pop-up menu.

[0=——Canonplug-inmodule (5-U4 I ————§
Setting File Image Preferences Film

Scan Mode: [ 24bit Color [~]

R

Output Device: [+ CRT{72dpi}) vkI
. Web{72dpi)
Resolution: BI(180dpi) 27 @E‘D"

e e BJ{360dpi)
Magnification: E
g BJ(720dpi}) EIE

. LBP{300dpi)
Image Size: LBP{600dpi) pi
Required/Frae: | OCR(300dpi) hsg |mb
OCR{400dpi}) :I
Eali

oo
EDRLEE e | TR

File(300dpi})
File(400dpi})
File{600dpi)
File(1200dpi})
File(2400dpi})

Canon Plug-in modulef

Ve Caution
( Q ¢ You can set the device categories in the pop-up menu in advance. You can

also add new devices to the pop-up menu. See Setting Preferences (p. 25).

______________o______________



STEP 1

Setting the Resolution and Magnification

The magnification of an image can be changed before scanning to accommodate
reproductions that are larger or smaller than the original. The settings can be
changed in increments of 1%.

12"/30cm

Scanning at 200% !
6"/15cm

Scanning with horizontal/

vertical 2x magnification
4"/10cm

Scanning at 50% 3"/7.5cm
’ 2"/5cm

Scanning with horizontal/
vertical 0.5x magnification

8"/20cm

Changing the magnification setting causes the resolution display on the control
panel to change correspondingly. This resolution setting is referred to as the
“scanning resolution.”

Output Device Resolution= 720 dpi, Magnification= 100%

e” "N e” "N
Resolution: Edub Resolution: =) .IEIdD'.
Magnification: ) 4 Magnification: ) 50| B4
g AN\ LB g AN\ J_sdBlz
— -) -~
Image Size: [ 4.0 * 600 |in e . Image Size: | 2.08% 3.00 | in
Required/Free | 36.4 / 9496 | b Magnlflcatlon Required/Free | 01 / 0495 | b
g . J m 3 . L m
changed to
50%

Magnification The scanning resolution changes
Scanning Resolution accordingly.

Hint
Magnification and Resolution

Why does the image size change with the magnification? Let us answer this
with an example using a “BJ (720 dpi)” output device. If you were to scan
an image with this device setting and set the magnification factor to 50%,
the scanning resolution will automatically change to 360 dpi. At this
setting, the image will be scanned at a resolution of 360 dpi and the output
device will convert this to 720 dpi, shrinking the size of the output in the
process because it will only have half the data with which to fill the space.

Image size = 5"x5" Image size = 2.5"x2.5"
(12.7 x 12.7cm) (6.35 x 6.35cm)
o o
Magpnification hd i 0%
50% _’ ° ° _’ o’
Scanned at ° ° Output device
360 dpi ° ° corrects to
720 dpi




STEP 1

To Set the Magnification Factor

i’ Set the desired magnification factor on the control panel.

[1=——————————— Ccanon plug-inmodule (5-U41=—————H
Setting File Image Preferences Film

Scan Mode: | B9 24bit Color v|

Dutput Device: [ BI(180dpi) :|
Resolution ‘:I'\'T")—I‘ Edm

Magnification %

Image Size 1,386 * 1,699 P
Required/Free 774 20059 mb

[EYEYEN 7 | &
OIOIO B 52| | Preview | can

Canon Plug-in module CE-U 4.1

Slider
Drag the slider bar in either
direction or use the arrow

keys to change the resolution.

____________________

Resolution: =S——
A N] 1
. . Click the up or down arrow to
Magnification: increase or decrease the
setting.
Click here to return the Click inside these boxes

=

magnification factor to 100%.  to enter values directly.

Hint
The Relationship Between Data Volume and Scanning Resolution
The higher the magnification and scanning resolution settings, the greater
the file size of scanned images. There are certain inconveniences associated
with large data volumes, such as longer processing times and the risk of
running out of memory resources. You are advised against setting the
resolution higher than necessary. For example, if you scan an A4 (21.0 x 29.7
cm (8.3 x 11.7 in.)) size image in the color mode, the amount of data varies
according to the resolution.

408MB

102MB

A4 color image

25.5MB

6.3MB
1.6MB

— 75dpi 150dpi  300dpi 600dpi  1200dpi
* These numbers are approximate and may differ from actual scan results.

______________o______________



STEP 1

Setting the Scan Mode

When an image is scanned, it is read as a collection of “dots.” The scan mode that
is selected determines how each of these dots is represented in the output. The
following four scan modes are available.

Black and White

Expresses images in two colors only: black or white. A dot is expressed as either
black or white according to its brightness level and the value set as the threshold
value, which can be freely set. Select this mode to output to a monochrome
printer.

8 bit Grayscale

Expresses a dot in up to 256 shades of gray. Select this option for scanning black
and white graphics and photographs.

Grayscale (14/16 bit)

Scans the image with finer tonal gradations. Select it when a particularly high-quality
image is required. Grayscale (14 bit) (16,384 shades between black and white) can
be selected with the CanoScan D1230U, and Grayscale (16 bit) (65,536 shades
between black and white) with the CanoScan D2400U. The data obtained with this
setting can only be used with Photoshop LE and certain other applications.

24 bit Color

Expresses a dot with 8 bits or 256 shades for each primary color - red, green and
blue (RGB) - for a total of 24 bits. A dot can be expressed in up to 16.7 million
distinct shades. Use this option for most color photographs.

Color (42/48 bit)

Scans the image with finer color gradations. Select it when a particularly high-
quality image is required. Color (42 bit) (16,384 colors per RGB channel) can be
selected with the CanoScan D1230U, and Color (48 bit) (65,536 colors per RGB
channel) with the CanoScan D2400U. The data obtained with this setting can only
be used with Photoshop LE and certain other applications.

Hint

@ Scanning the same image in the four different scan modes produces
different file sizes. By size, black and white mode requires the least disk
space, followed in order by the grayscale and the color modes. Before
scanning, check the data volume indicated on the control panel.

The numerator indicates the amount of image stze: [ T365% 1699 o

disk space required for the scanned image = _
‘ - e equired/Free: 77 /20059 |mb l
while the denominator indicates the

amount of disk space available. When the = | =

required space exceeds the available space OIQIOI -EI 2] | preview | somn
or 2GB, the scan button is unavailable.

Canon Plug-in radule CS-1 4.1 =
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Operating Procedures

P Click the arrow beside Scan Mode.

[ =————— Canon plug-in module (5-U4.1
Setting File Image Preferentgf -Fﬁn?‘

Scan Mode: (B 24bitColor  y  [+]
> ’

Outout vevice (Do) [
Resolution ?@Z. Edpw

Magnification E Z

Image Size 1,386 * 1,899 pi
Required/Free 77 42,0050 mb

Selecting the box opens
the pop-up menu.

AEE B g =
OIOO B 52| Preview | sean

Canon Plug=in module CS-U 4.1

P Select a scan mode from the pop-up menu.

I Black & White -in module C5-U4.1
setting File || I BbitGrayScale |7,

] 16bit GrayScale

ELENRRGLE =] 24hit Color -

Output Device: | BJ(180dpi)

Resolution :.'@:. E dpi
Magnification Ex

Image size: [ 1386+ 1,898 b
Required/free: [ 77 72,0958 |mb
EYENEY 2| =
OIC) ™ = 21| Preview Sean

Canon Plug-in medule CS-U 4.1

(@ Caution
¢ If you select 14/16 bit Grayscale or 42/48 bit Color for a software applica-

tion that does not support these options, the system may hang up when
you attempt to execute the scanning job with either selection. Before you
use these settings, check the specifications to determine whether or not
14/16 bit Grayscale and 42/48 bit Color scanning is supported. Adobe
Photoshop (Ver. 3.0 or later) and Adobe Photoshop LE supplied with this
package support these modes.

¢ If you scan an image with a version of Adobe Photoshop compatible with
42 bit Color, a 14/16 bit Grayscale or 42/48 bit Color image is scanned as a
16-bit Channel Mode image.

¢ 14/16 bit Grayscale and 42/48 bit Color images generally cannot be
printed without modification. To print them out, first transform them into

8-bit Grayscale or 24-bit Color images, respectively.

______________o______________
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Verifying the Image before Scanning

Before initiating the final scan, it is advisable to check the intended results with the
Browser function. The image in the browser window is more accurate than the one in
the preview window, allowing you to verify the results more precisely before scanning.

To Verify the Image

ib

vVVY

Set the magnification and scan mode to the appropriate settings.

Click on the [Browser] button.
* The selection frame will appear in the preview window to enable a portion of the

image to be selected.
¢ The size and shape of the selection frame cannot be changed because it is

automatically determined by the scanning resolution.

Canon plug=in module C5=U4.1

Setting File Image Preferences Film | Selectascanares.

Scan Made: [ 24bit Color [+]

Output Device: [ BJ{180dpi) |L]
Resolution: :I@:I' Edpi
Magnification: E%

Image Size: | 1,386 * 1,899 ||3><

Selection Frame

Required/Free: | 7.7 / 2,0959 |mb

o b

3 K}
Qala]; Bl 5 | a
E@@; W Preview Scan

Canon Plug=in module CS5-1U 4.1

Move the pointer in the selection frame inside the preview window.
e The mouse cursor will change to a “+” sign shape.

Move the Selection Frame to the desired position with the mouse cursor.
¢ Moving the mouse will move the Selection Frame.

Click the mouse button when the selection frame is in the correct

position.

¢ The image will be scanned and the browser image displayed in the middle of the
monitor.

Once you have examined the browser image, click the mouse button
again to close the browser window.

e The browser window will close.
e |t does not matter where the mouse cursor is positioned to close the browser window.

______________o______________
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Rotating the Image

You can rotate the image in the preview window clockwise to the right
E} 'C. G or counterclockwise to the left in increments of 90 or 180 degrees. To
rotate the image, click the appropriate button.

Caution
¢ If you rotate the image in the preview area, the scanned image will also
rotate.

Operating Procedures

i’ Use these buttons to rotate the image:

2=
OlQlOl El?}’l Preview Scan

njmodule C5-U 4.1

Cangn Plyg-i

To rotate the image clockwise 90 degrees

To rotate the image clockwise 180 degrees

To rotate the image counterclockwise 90 degrees

______________o______________
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Setting Preferences

The Preference settings determine how Plug-in Module CS- [EEEHH

U operates for the following options: output device Aepect Rati.
(printer, files), scan area setting method, size display units, Unit...
preview window size. You can change these options at any ARSI T
. . Shut off lamp time...
time or restore the factory default settings. To change any Resets Default Settings...
of these options, use the Preferences menu. Close Plug=In After Scan

v Platen

Film

Output Device

Adds new output devices or file formats to the pop-up menu in the control panel.
Devices are displayed by name. Resolution and other settings can be changed for
the devices or the devices can be removed.

Output Device Settings ——

Adds a new device. Gutput Device Name : (RGN OuTBUEDVIER |
Output Device : ion : (:_ dpi
4 OCR(300dpi) _| P[0 _|f
[ OCR(400dpi) y
& OCR{G00dpi} Edit...

& FAX(200dpi)
& File(100dpi}
& File(150dpi}
& File(300dpi)

Allows you to change
the name and

: H Output Device Mame ; | Postcard Pri
A it resolution setting. put Bevitemame m =
File(600dpi} H P
A File(1200dpi) . . . -E-
[\A Postcard Print(300dpi) — =

Allows you to remove a device from the list.

* The preset devices cannot be edited or deleted.

Aspect Ratio

To set the size of the area to be scanned, drag the mouse to size the selection
frame in the preview window. The area inside the borders of the selection frame
will be scanned.

Aspect Hatio
15K = When the [Independent] setting is selected, the selection
Mose: (Paper sie (oriral frame can be freely resized and reshaped by dragging it.
=
Aspect Hatio
Styie:[onmstralne When the [Constrained] setting is selected, choose a
Mose: Bl paper size in the [Mode] option. The selection frame will
Witth: B HDEI'S!EE (Partraity j . . . . . )
PRl R have a fixed aspect ratio (height to width ratio) when it is
custom resized in the preview window.

______________o______________
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Unit

Specifies the units that define the size of the scanned image.

Unit Settings Dialog

Unit Settings

Unit: ) Pixel {px)
Inches (in.)
) Millimeters (mm)
) Centimeters {cm)

-

Preview Window

I Image Size: 770 % 1055 in

Required/Free: 77/ 2,0950 b

P (RERE

2=
OQIGI _-;I)‘? Freview | Soan

Canon Plug-in module C5-U 4.1

The units displayed in this section of the control panel will change.

You can size the preview window and set its resolution. Enter a large value for a
large preview window size. You can also use this feature to set the auto preview
and preview cache options.

Preview Window Settings Dialog

Preview Window Settings

Window size

Resolution:

Width X Height:

Memory for execution: about
Memory required to save the file:

Preview setting

Current settings Ne settings
20 ]dpi dpi{ 20 ~ )
x px x 233 |px

O Automatically perform a preview
@ Save preview image
) None

Cancel 0K

Caution

&

Allows you to enter values
and change settings for the
preview window options.

The maximum values are
determined by the type of
monitor you are using.

Click the appropriate radio
button for the function you
want to switch on
(Automatically perform a
preview, Save preview
image and None). Only one
button can be selected.

e Changing the preview window size will cause the image previously

displayed in the preview window to disappear.

Hint

=

¢ If the “Save preview image” option is selected, the last preview image will

appear in the preview window when Plug-in Module CS-U is launched
again after quitting once. This reduces the steps required to rescan the
same image repeatedly.

______________o______________
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Shut off lamp time

This option turns off the scanner lamp, which is otherwise continually on while the
power is on, to save power if it remains idle for a specified length of time. It can be
set to any interval of 4 minutes between 4 and 56 minutes (the actual shut off time
may vary slightly from the specified interval). This setting is automatically set to 12
minutes when Plug-in Module CS-U is first installed.

Shut off lamp time setting

Shut offlamp timel 2] EIi’ninutes

Click the up or down arrow in the
spinbox to increase or decrease the
number setting or enter a number

Reset Default Settin

directly into the entry box

gs

Returns the preference settings and all other settings to the factory default
settings. The tables list the major default settings.

Scan Mode 24bit Color
Magpnification 100%

Unit Pixels

Basic Resolution(Platen) 72 dpi

Basic Resolution(Film) 600 dpi
Control Panel Position Center

Image Recommended
Unsharp Mask On

Descreen Off

Shut of Lamp Time 12minutes
Film Type Color Negative

Close Plug-in After Scan
This setting determines whether or not Plug-in Module CS-U closes automatically
after completion of the scanning job. After you install Plug-in Module CS-U, this

setting is set to off. To turn this feature on, open the [Preferences] menu and select
[Close plug-in after scan].

Platen/Film
When a film adapter unit (FAU-S12/513) is attached to the scanner, the [Film]
option in the pull-down menu can be selected. Select either [Platen] or [Film] to

make the respective scanning method effective, which is indicated by a check mark
in the pull-down menu.

Caution
¢ \WWhen switching between the [Platen] and [Film] options, the scanner has to
adjust the lamp output, which may require a few moments to take effect.



STEP 1

Operating Procedures
i’ Open the [Preferences] menu in the control panel.
Preferenc:es

Qutput Device...

Aspect Ratio...

Unit...

Preview Window...

Shut off lamp time...
Resets Default Settings...

Close Plug-In After Scan

+ Platen
Film

Select the desired option from the pull-down menu.

¢ Selecting any one of the Output Device, Aspect Ratio, Unit or Preview Window
options displays the respective dialog. Choose the desired value in the dialog and
select [OK] to change the setting.

¢ A confirmation dialog will display if Reset Default Settings is selected. The
settings will be reset if [OK] is selected in that dialog.

® You can select either [Platen] or [Film]. The selected one is checked.

______________o______________



Scanning

Step 2 presents the procedures for conducting the final scan,
saving the scanned image in a file and editing image files.
Follow the procedures below to perform the final scan.

mu  Setting the Scan Area =¥ p. 30
m Zooming =¥ p. 31

v
mu  Scanning = p. 33

v
== Saving Scanned Images =¥ p. 34

mu  Scanning Film =* p. 35
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Setting the Scan Area

Using the image in the preview window, you can define the actual area to be scanned.

Operating Procedures

Position the pointer in the preview window.
The [+] symbol marks the current position of the pointer.

Click and drag the mouse in the direction you want to define on the
image as a frame.

The selected area is enclosed in a dotted frame. The area enclosed in this dotted
frame is the area that will actually be scanned.

[0 =— canon plug-in module (5-U4I————§&
Setting File Image Preferences Film R:255/255 G:255/255 B:1255/255

Scan Mode: [ S 24bit Color [~]

Dutput Device: | BJ(180dpi) [~]
Resolution: ‘:.@:.‘ Edpi
Magnification: E%

Image Size: | 657 * 954 | px

Selection Frame

Required/Free: | 1.8/ 2,0959 |mb

===
OlQlGl _-;lfl Preview |  Scan

Canon Plug-in module C5-U 4.1

¢ You may drag the frame in any direction.

e Clicking the mouse button outside the selection frame causes the selected area
to be deselected.

¢ Moving the mouse cursor within the selection frame changes it to an
omni-directional arrow [ 4 ]. Dragging the cursor in this state will cause the
selection frame to move without changing its shape.

¢ Placing the mouse cursor over the dotted line of the selection frame causes the
cursor to change into one of four shapes [ 1 ] [—][~\]1[.~]. Dragging the
selection frame with the mouse cursor changes its shape.

¢ Double-clicking the mouse button anywhere in the preview window selects the
entire image.

Hint
@ ¢ To specify small areas with precision, it is convenient to expand the
preview display with the Zoom In button. See Zooming (P. 31).

______________o______________
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Zooming

zoom features. You can use the zoom function to select an area with

| Q ':ﬂ E&h You can specify a selected area of the image for enlargement with the
high precision, or to select small areas for scanning.

Procedures to Zoom In

Select the area you want to enlarge with the zoom function.
See Setting the Scan Area (p. 30).

[0 =——canonplug-inmodule (5-U4 I ———§
Setting File Image Preferences Film

Scan Mode: [ S 24bit Color [~]

Dutput Device: | BJ(180dpi) [~]
jan: :@:s B
Resolution Y . Edm
Magnification: El%

Image Size:

Selection Frame

356 * 486 | px

Required/Free: | 508 / 2,095,092 |kb

2=
OlQlGl El?}’l Preview Scan

Canon Plug-in module C5-U 4.1
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Click on the Zoom In button [&].

The selected area will be displayed in expanded form.
If you want to enlarge the image again, reduce the size of the area selected with

the frame and click the Zoom In button again.
[l =———— Canon plug=in module C5-U4.1

B

Setting File Image Preferences Film

Scan Mode: |2 24bit Color [~]

Dutput Device: [ BI{180dpi) [~]
ion: :@:s i
Resolution A . Eldp]
Magnification: El%

Image Size: [ 354 % 487 | px

Required/Fres: | 507 / 2,095,992 |kb
="

= A3
AR B 5=
C) W E | ?l Preview Scan

Canon Plug-in module C5-10 4.1

Click the Zoom Out button |2 ] to restore the view prior to zooming.
Click the Zoom Reset Button |Q| to restore the size just after previewing.

[

* The image cannot be zoomed unless an area is selected.
* The selection can be zoomed up to six times consecutively. If the selected

area is too small, the Zoom In button will be disabled and the selection
cannot be zoomed.
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Scanning

Once you have set the magnification and scan mode, you may proceed with the
scan. Once the scan is complete, close Plug-in Module CS-U. The scanned image
will appear in the application software, such as CanoScan Toolbox or Adobe
Photoshop LE.

Scan

To Initiate the Scan

Specify the Scan Area.
See Setting the Scan Area (p. 30).

# Click on the [Scan] button.

D =~ canon plug_in module CS_U4_] =~ E
Setting File Image Preferences Film

Scan Made: [ 24bit Color [+]

Output Device: [ BJ(180dpi) [+]
Resolution: ‘:.@:.‘ Edpi
Magnification: E%
Image Size: | 540 * §22 |
Required/Free: 1.3/ 2,0959 mb
- 5

ﬁ' B ‘
OlQlGl _-J;l’}?l Pre‘ew Scan *
Canon Plug-in madule CS-U 4(\ < L _ 4

e The scan will start.

Click [ (close box) to guit the Plug-in Module CS-U.

¢ When you select [close Plug-in After Scan], the Plug-in Module CS-U quits
antomatically.

] Hint
@ * The scan button cannot be clicked if the scan area is set too small (less
than 64x64 pixels) or not specified.
¢ The scan cannot be performed if the required memory is larger than the
free disk space.

______________e______________
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Saving Scanned Images

Follow this procedure to save a scanned image with the parent software
application. The example below shows how to save a scanned image with Adobe
Photoshop LE. See the Adobe Photoshop LE User’s Guide.

Operating Procedures

After an image is scanned, the image is displayed as “Untitled.” When you save
the image you can give the file a name and select the folder where it is to be
stored.

i’ Open the [File] menu and select [Save As...]. The Save dialog will open.

% (& Adobe® Photoshope 5.0 LE[ v ] = EnglishHD
Open... ®0 =] s
Ffj Goodies =
Save. 5 3 ety
5 xS N
" . [ License Agreements (ew )
Save a Copy.. =I%S [ffi My Album -
Revert
save this document as:
Import » [Untitied-1 | o)
Save
Export »
Format: | PDF vl
Page Setup.. {#P
Print... ®P
Preferences »
Adobe Online...
Quit ®Q

p Select the folder you want to use for the file.

(R =i —EnglishHD To select a folder, click the arrow and select
- e shopsSOLE | ot the name of the folder in which you want
@ Desktap to save the file.
L (Crew( )
Save this document as:
Untitled-1 |
Format: [ Photoshop [ ]

P Enter a name for the file and click the [Save] button.

(G My Album [ v | = EnglishHD
= Eject
[(New( ]
Save this document as:
Photo-1 | (| Enter a file name here.
Format: [Photoshop [~

______________o______________
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Scanning Film

Use the following procedures to scan films when the Film Adapter Unit FAU-S12/
FAU-S13 option is attached.

( ? Caution
¢ Please see the Film Adapter Unit documentation for installation and film
placement instructions.

Operating Procedures

i’ Insert the film into the film guide and place the assembly on the
scanner’'s document glass (platen). Close the film adapter unit.

# Open the [Preferences] menu and select [Film].

¢ The shape of the preview area will change to a square and you will be able to
select the [Film Settings] option from the [Film] menu.

Preferences
Output Device...

Aspect Ratio...
Unit... [O0=—————————— canon plug-inmodule (5-U41=—————H

Preview Window.., setting File Image Preferences Film
Shut off lamp time... =
Resets Default Settings... et iz, ||_JekiiiE Uiy =
Close Plug-In After Scan Output Device ﬂ |
v Platen N
Resolution: =—F—— -m dpi
Film v . EI P
’ Magnification %
ala] (8] 5
B . R

Canon Plug-in module CS-U 4.1

P Open the [Film] menu and select [Film Settings].

R e

______________o______________
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P Select the appropriate film type and size.

¢ Click beside the positive or negative film option and one of the 35 mm, 120 format
and 4x5 inch sizes as appropriate. Also set [Auto Exposure] option on or off.

Film Settings

FilmType: @ Color Negatives (2 Black and White Negatives
3 Color Positives {3 Black and White Positives

Film Size: @ 35mm (Sleeve) (3 35mm (Mount)
) 120 Format {(4.5x6) ) 120 Format {6x6)
{3 120 Format (7x6) ) 120 Format (8x6)
{3 120 Format {9x6) ) 120 Format {12x6)

[oF" <]

4 Auto Exposure

Auto Exposure

This function is available when [Film] is selected. When On, this function
automatically sets the exposure data (light intensity and compensation for each
RGB channel) to match the brightness of the film and produce the best scanned
image. The default setting for this function is On. Set it to Off when you wish to
perform the exposure compensation with an application program after the scan or
if you wish to achieve an under-exposed effect.

Save Exposure Data

This function is available when [Film] is selected and [Auto Exposure] is set to On. If
a check mark is placed beside this option, you can scan a new film using the
exposure data from a prior film. If, for example, a film is shot under the same
lighting conditions and settings as another, several frames can be scanned with the
same exposure data, making it possible to achieve finely matched color tones.

Ve Caution

( ? ¢ Please set the area so that it fits within the boundaries of the selected
film size when [Auto Exposure] is set to On. If it extends beyond the edges
of the film or is too small, the auto exposure function will not operate
correctly.

¢ At low temperatures, the preview scan may take some time to start

because the fluorescent lamp inside the scanner is not sufficiently
warmed. If a preview image is too bright or dark in a low-temperature
environment, please perform a second preview scan.

______________o______________
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p Preview the film and select the area you want to scan.

O =———Canonplug-in module (5-U4.1=————H

Setting File Image Preferences Film Fi250/251  Gi2S/251  B:i258 251

Scan Mode: | 24bit Color -

Dutput Device: [ File(600dpi) [+]
Resolution ‘.:@:.'EUD‘

Magnification [Ciodf]=

Image Size 850 * 552 px
Required/Free mD

N

QA E |
P

Canon Plug-in module CS-U 4.

can

p Set the scan mode, resolution, magnification and tone adjustment
settings as required.
With CanoScan D2400U, [Remove Dust and Scratches] function is available.(p. 38)

p Click on the [Scan] button.

Untitled-1 & 50% (RGB;

Progress

Import: Canon P1 C5-U4.1 #
L

: !

50% Doc: 1.37MA37M [ B 4]
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Remove Dust and Scratches
(CanoScan D2400U only)

This function is available with CanoScan D2400U and FAU-S13 when [Film] is
selected in the [Preferences] menu, and the film type is set to [Color Positives] or
[Color Negatives]. The FARE (Film Automatic Retouching and Enhancement]
function automatically produces a scanned image with the areas under small bits of
dirt or scratches removed. The available settings are [None], [Soft], [Standard] and

[Hard].

Soft: Compensates for high-contrast dirt and scratches. At this setting,
it may not be possible to restore areas under large flecks of dirt or
scratches.

Standard: This setting is recommended for most purposes.

Hard: Compensates for low-contrast dirt and scratches. Although its may
restore areas under large flecks of dirt or scratches, it may leave
artifacts after processing.

(/gcp Caution
\ ¢ This function cannot be used with black and white film. It may also fail to

have any effect on KODACHROME film.

¢ Areas under dirt and scratches may not be removed if the selected scan
area is too small.

e There are occasions when areas under dirt or scratches on the top or
bottom edges cannot be removed.

¢ If the edge of the film guide is included in the scan area, the areas under
dirt or scratches at the boundaries of the scan area may not be removed.

* The Remove Dust and Scratches function will not work at resolutions
above 2400 dpi. Please reset the output resolution at, or within, 25 and
2400 dpi. In addition, lower the magnification so that the scanning
resolution remains at 2400 dpi or less. If, for example, the output resolu-
tion is set to 1200 dpi and the magnification to 400%, the resulting
scanning resolution is 4800 dpi, or four times the output resolution. (1200
dpi x 400% = 4800 dpi)

Operating Procedures

P Open the [Image] menu and select [Hard], [Standard] or [Soft] from
the [Remove Dust and Scratches] submenu.

Image
+ Recommended
ColorSync

None

Tone adjustment...
Remove Dust and Scratches (Standard) B None
+ Unsharp Mask

High-speed Scan Mode

______________o______________



Adjusting Scanned Images

Scanned images may be corrected for brightness and color tone

or edited in a variety of ways.

The potential adjustments vary with the scan mode utilized in the preview.

Adjustments to the scanned image may be made after the image is previewed.

8-bit/14/16bit Grayscale and 24-bit/42/48bit Color:

== Tone Adjustment =* p. 40

wu Histogram Settings =? p. 41

w= Tone Curve Settings =¥ p. 44

= Brightness and Contrast Settings =* p. 47

= Adjusting Color Balance =¥ p. 49

w= Gamma Value Settings =¥ p. 50

Black & White: w Adjusting Threshold Value = p. 52
24-bit Color: = Auto Tone Correction (ColorSync™) =% p. 53
== Unsharp Mask =¥ p. 54

w= Descreen =» p. 55

== High-speed Scan Mode =¥ p. 56

== Saving/Recalling Settings =» p. 57

== Scanning Techniques ~» p. 59
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Tone Adjustment

Use Tone Adjustment to enhance the brightness or color of the image in the preview area.
Open the [Image] menu and select [Tone Adjustment], or dlick the [Tone Adjustment] button,
to open the Tone Adjustment dialog so you can enhance the preview image.

You can also click the [Auto Tone Adjustment] button so the histogram highlights and
shadows are adjusted for you automatically to the optimum settings.

Caution
( Q ¢ Adjustments cannot be made when the ColorSync option is selected (p. 49).

| Image Menu
O Canon plug-in module (5-U4.1=———— 5
pr— e — H
Setting File 1[:8 Preferences Film Ri255/255 G:255/255 B:255/255 | Dlsplays the RGB
P 2 Recommended values at the
Fan te% - colorsync : current cursor
None e
Output Devic = position.
Tone adjustment... Pre—adjusted value/
Resolutiof —Descreen Hpi t-adiusted val
|+ Unsharp Mask post-adjustea value
Magnificatio = e
High-speed Scan Mode
Image Size: | 540 * 22 | px
Requirad/Free: | 13/20953 |mb Auto Tone
Adjustment
e
B | EL Button
O|Q|G| E ,}? Preview Sean .
Canon Plug-in module C5-1 4.1 TOne AdJUStment
Button

Tone Adjustment Dialog

The Tone Adjustment dialog contains tabs for the following features: histogram, tone curve,
brightness/contrast, color balance, and gamma. If black and white has been selected as the
scan mode, the threshold feature also becomes available on the histogram tab.

The settings selected in the Tone Adjustment dialog are also reflected in the next preview
image. To scan a new item, ensure that you click the [All Reset] button to restore all of the
settings to their default values.

o Tone Adjustment =]
——— Click the @
appropriate
tab.
e . g [5]
5[0 1| [ =
AlReset | [_Load.. | [_Save. |
= =g
Here is the Tone Adjustment dialog with all Here is the Tone Adjustment dialog you will
the tabs you will see when color or grayscale see when black and white is selected as the
has been selected as the scan mode. scan mode. Only one tab is available.

______________o______________
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Histogram Settings

The data comprising an image contains a variety of brightness settings ranging
I from shadows to highlights. These settings are represented in Plug-in Module CS-U
by values ranging between 0 and 255. The difference in these values determines
the image’s contrast. To show how much of the image data falls into each
brightness setting, Plug-in Module CS-U contains a histogram feature that shows
this data distribution clearly. With the histogram you can adjust the level of
shadows and highlights to achieve beautiful tones with the best possible contrast.

: Hint
@ ¢ You can enhance images with the histogram options only when the image
has been previewed in the color or grayscale scan modes.
* You cannot enhance the image with the histogram when ColorSync™ is
selected.

How to Interpret Histograms

You can select the entire image or specify an area for which a histogram will be
generated. The height of the peaks of the histogram is directly related to the
volume of data with the corresponding value.

Portion with o
Highlights Distribution of data
with a bias toward

highlights.

Portion with
Shadows

3
B

Distribution of data
with a bias toward
shadows.

f

¥
B

Distribution of data
widely distributed
between shadows and
- | highlights.

Entire Image

3
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How to Adjust Histograms

To change the contrast in an image, the distribution of data between shadows and
highlights can be adjusted by dragging the shadow and highlight marks at the bottom
of the histogram. All of the data lying to the outside (left) of the shadow mark is
changed to a zero value and all of the data lying to the outside (right) of the highlight
mark is changed to a 255 value. The examples below show adjustments to improve the
contrast. Use the [Auto] setting to adjust the histogram for most jobs (p. 417). The
graphs below show images adjusted with the Auto setting.

IMAGE Image with a bias IMAGE Image with abias |MAGE Image with well
toward highlights toward shadow distributed data

|='A:AI A—Ei I—’A_:A*II
Move the shadow mark Move the highlight mark Move both the shadow and
toward the highlight end. toward the shadow end. highlight marks inward.

To Adjust a Histogram

ip

p
p

Specify the area of the image (the entire area to be scanned) for which a
histogram will be generated. See Setting the Scan Area (p. 30).

The histogram will not display correctly if an extremely small area is selected. To select
small areas, first expand the display with the Zoom In button. See Zooming (p. 31).

Click the histogram tab in the Tone Adjustment dialog to display the
histogram options.

Click the [Auto] button.

Although you can freely move the shadow mark and highlight mark to another
position, the image can be adjusted easily for optimum effect with the Auto
button.

______________e______________
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The histogram settings can be adjusted for all channels (Master) or for individual
channels (R, G, B). The selectors are displayed to the left of the histogram graph
(Master, R, G, B). The Master selection is unavailable if Grayscale has been

selected as the scan mode.

Shadow Mark

All of the data to the
left of this mark is set
to the shadow (0)

Clicking directly on this bar causes the shadow or highlight
mark, whichever is closest, to advance to that position.

— Highlight Mark

value. Drag the mark

O % ToneAdjustment Sea—=

= All of the data to the

to the right or left.

Displays the current
level at the shadow
mark. Click the up or
down arrows in the

right of this mark is set
to the highlight (255)

value. Drag the mark
to the right or left.

Displays the current

spinbox to increase or

decrease the setting or
enter a number directly
into the entry box

(0~245).

level at the highlight
mark. Click the up or

down arrows in the

To restore the histogram -
settings, click this

[Reset] button.

To restore all settings
to their defaults, click
the [All Reset] button.

 Reset [J spinbox to increase or
— decrease the setting or
aiTReset ] ([todin1) (avenT] enter a number directly
into the entry box
[[caneer | [ ok | (10~255).
L— The Tone Adjustment

settings can be saved
in a file and reloaded
for later use.

Black Eyedropper Button ——
Click the Black Eyedropper

and click the position in the
preview image you want to

set to black (0).

Click on the [OK] button.

Auto Button
Automatically sets
the highlight and

shadow settings for

optimum effects.

—— White Eyedropper Button
Click the White Eyedropper
and click the position in the
preview image you want to
set to white (255).

The preview image will change according to the values specified with the

histogram.

Hint

=

from the [Image] menu.

¢ The histogram dialog can also be displayed by selecting [Tone Adjustment]
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Tone Curve Settings

You can edit the tone curve directly by changing the shape of the line on the

F’ graph. When you change the setting by manipulating the curve, you can perform
fine adjustments in the brightness of only the shadows, only the highlights, or both
the shadows and highlights.

Hint
@ * You cannot use this feature with the black and white or color scan modes
when ColorSync is selected.

Manipulating the Graph

The following examples show you how to manipulate the graph to change the
settings. When you test these settings yourself, you can see the changes
immediately reflected in the preview window or the browser to achieve many
interesting effects.

Drag the mid-tones of the input side
) (scanned image) into the highlights of the
Unadjusted Curve output side (displayed image)
OUTPUT H H H OUTPUT ' 7
i : : If you want to
R #----1 brighten the
| | light areas .

...................

' '
B ] INPUT

Reverse the starting and end points of the
line to invert shadows and highlights.

OUTPUT

....................

_— 1 = .....

If you want to
invert the

shadows and : | | g
highlights ... B NPUT

(If the image is in color, the colors are
switched to their complementary colors.)

______________Q______________
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To Edit the Tone Curve
i’ In the Tone Adjustment dialog box, click the tone curve tab.

p Change the tone curve in any direction to adjust its shape.

You can adjust the setting for each To create a control point on the line, just click anywhere
channel: R (red), G (green), B (blue) in the graph. After a control point is displayed in the line
or M (master). You can adjust each you can click to move it in any direction. As you move it
channels independently. (You can to another location, the value changes. You can set
adjust RGB only for a color image.) several control points on the tone curve.
0 =——Tone Adjustment =———o"=Ho
Shows the input and
rAVAERYA output level at the
point under the pointer
® (control point) in the
@ graph, expressed as a
@ value from 0 to 255
where 0 is the darkest
I and 255 the lightest.
Iirte: té)er?amf s?t?iigs Doprie@ If the output level is
dic this button. peser ] v s rests 1
lighter image.
[ AnReset | [ Load.. | [ Save.. |
[ Cancel ] |[ OK ]|
To restore all the The Tone Adjustment settings can be saved in a file
default settings, click and reloaded for later use.

this button.

Click the OK button.
The image in the preview window changes to reflect the new settings.

______________G______________
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The Relationship Between the Tone Curve
and Image Brightness

The Gamma values fall with a range of 0.01 to 10.00. A value of 1 appears as a
straight line in the graph, and if the value is any value other than one, the line on
the graph will appear curved. The relationship between the shape of the curve and
image brightness is explained below.

Gamma Value = 1

Input and output and are equal
and the curve appears as a

straight line, and the input |:|
image is displayed on the
screen without adjustment.

Output

Input

Gamma Value > 1

The data bends upward over
the range of input values from
shadows to highlights, making
the adjusted image brighter in T
the display.

Output
—

Input

Gamma Value < 1
The data bends downward over
the range of input values from
shadows to highlights, making l D
the adjusted image darker in
the display. s

Output

Input

CAUTION
@ ¢ The tone curve cannot be adjusted manually in one of the color scan
modes when ColorSync is selected because the color balance is adjusted
automatically.
* The tone curve cannot be adjusted for a black and white image because
mid-tones are shown as either black or white. To adjust the brightness of
a black and white image, use the threshold setting (p. 48).

______________Q______________
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Brightness and Contrast Settings

You can adjust the image with two slide bars, one for contrast and one for
brightness. Use this method to adjust an image before scanning if it is slightly out
of focus or too dark.

Hint
@ * You cannot use this feature with the black and white or color scan modes
when ColorSync is selected.

Contrast

Contrast is the difference between the lightest light and the darkest dark in the

image. A high contrast setting creates a great difference between light and dark
shades, and there is a very sharp distinction between light and dark areas of the
image. A low contrast setting creates a small difference between light and dark

shades, and the distinction between light and dark areas of the image are not as
obvious.

Contrast = 128 (Normal) Contrast = 170 Contrast = 100

If the image appears slightly out of focus, increase the contrast setting to sharpen
the image. If the contrast setting is too high, shadows will blacken and the
highlights will wash out.

Brightness

Brightness is the overall lightness or darkness of an image without changing the
contrast. Adjust the brightness setting to change the overall lightness or darkness
of the entire image. If the brightness setting is too high, the highlights will wash
out, and if too low, the shadows will blacken.

Brightness = 128 (Normal) Brightness = 190 Brightness = 80
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To Adjust the Brightness and Contrast
i’ In the Tone Adjustment dialog click the brightness/contrast tab.
Adjust the brightness/contrast settings by dragging the slidebars,

changing the value with the spinbox buttons, or entering the value
directly into the entry box.

Drag the slidebar left or right to adjust the
brightness setting.

0 ==——Tone|Adjustment —iaa—" g
VAV VE . .
m You can also click the up or down arrow in the
3 === | 5] spinbox to raise or lower its value or enter a
© m number directly into the entry box (-127~+127).
— L]
Drag the slidebar left or right to adjust the
Contrast setting.
{_Reset ] I The Tone Adjustment settings can be saved in a
1 file and reloaded for later use.
[ anReset | [ Load.. | [ save.. |
[ cancel | [ ok |

To restore all the default settings, click this button.

To restore the brightness/contrast default settings, click this button.

Click the [OK] button.

The settings will be reflected in the image currently displayed in the preview
window.

______________Q______________
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Adjusting the Color Balance

You can enhance color matching by adjusting the color balance of one or all of the
ﬁ three primary colors: red, green and blue (RGB). Use this feature to adjust the color
balance when you see an over-abundance of a color in a scanned image.

Hint
@ * You cannot use this feature with the black and white or grayscale scan
modes, or with the color scan modes when ColorSync is selected.

* There may be wide differences in the contrast and hue of the display
image and printout, depending on the monitor and printer settings. You
may have to adjust the settings and execute some test prints to attain the
best match between what you see in the image on the display and in the
printout.

Operating Procedure
i’ Click the color balance tab in the Tone Adjustment dialog.

Adjust the color balance for each or all of the primary colors: red, green
and blue (RGB).

Adjust the color by dragging the slidebar

0 =——Tone|Adjustment ——H left or rlght
[EAENF\/B\
@ cﬁ C[E] Click the up or down arrow in the spinbox
@ = p E to increase or decrease the number value
- - or enter a number directly into the entry
o] box (-127~+127).
_Reset ] | I The Tone Adjustment settings can be
! ! saved in a file and reloaded for later use.
[ All Reset ] [ Load... ] [ Save... ]
((cancel | [ ok ||

To restore all the default settings, click this button.

To restore the color balance default settings, click this button.

p Click the [OK] button.

______________Q______________
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Gamma Value Settings

By adjusting the gamma value, you can more closely match brightness of the
displayed image to the printed image. Adjust this value if what you see on the
screen is very different from your printout.

Hint
@ * You cannot use this feature with the black and white scan mode, or with
the color scan modes when ColorSync is selected.

Matching the Gamma Value to the Display Characteristics

Not all screen displays reproduce color tones in exactly the same way, and this
reproduction method is expressed as a gamma value from 1.4 to 2.2 and normally
reproduces a slightly dark image.

In order to avoid this and reproduce an image that is faithful to the original, the
gamma value must be adjusted in Plug-in Module CS-U. Plug-in Module CS-U can
adjust the pre-set screen gamma value of 1.8, but if the screen has a gamma value
other than 1.8 then the gamma value for that screen must be set.

Gamma value

Plug-in Module CS-U and the screen display have different gamma values. During a
scanning job Plug-in Module CS-U receives the image read from the scanner as
input and sends it to the parent application as output. The gamma value in this
interval where Plug-in Module CS-U converts input to output is the Plug-in Module
CS-U gamma value.

On the other hand, the data received from Plug-in Module CS-U as input is sent to
the screen display as output. The gamma value in this interval where the image
input from Plug-in Module CS-U is converted to output for the screen display is the
screen display gamma value.

Setting the screen display gamma value causes the scanner gamma value to be
calibrated automatically as the inverse value. For example, if the screen display
gamma value is set for 1.8, then the scanner gamma value is calibrated for 0.56
(the inverse of 1.8).

Hint
@ ¢ Please read the documents shipped with your display or contact the

manufacturer’s customer service department to obtain the correct gamma
value for your particular display model.

¢ If you intend to adjust the color tone with ColorSync™, change the
settings in the ColorSync™ control panel (found within the Control Panels
folder) and do not manually change the gamma value settings as
described in the following pages.

______________o______________
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To Change the Gamma Value Settings
i’ Click the gamma tab in the Tone Adjustment dialog.

p Click a pre-set value or the custom option.

] =—Tone Adjustment ——H Click the appropriate radio button to select a
numerical setting.
—— .
D10 D14 @15 022 O After you click the [Custom] button, you can
@) sy drag the slidebar to adjust the setting, or you
L — |_|@ can enter a value directly into the entry box.
Q10 Q14 Q18 Q22
@ Custom
A== 0]l
Reset I |
Drag left or right to  Click the up or down
(_pnReset | [_Load.. | [_save.. | change the setting.  arrow in the spinbox to
[(cancet | ok || increase or decrease the
value or enter a number

directly into the entry box
(0.1~10.0).

The Tone Adjustment settings can be
saved in a file and reloaded for later use.

To restore all the default settings, click this button.

To restore the gamma default settings, click this button.

Click the [OK] button.
The changes are reflected in the image currently displayed in the preview window.
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Adjusting the Threshold Value

When the scan mode is set to black and white, the image brightness can be

I adjusted. The threshold value setting determines whether a halftone will be
expressed as a black or a white data point. The possible threshold values range
between 0 and 255. Below a given threshold value, all data is converted to black.
Likewise, all data with a value above the threshold is converted to white.
Accordingly, higher threshold values produce darker images while lower threshold
values result in brighter images.

Threshold Value = 128 (Standard) Threshold Value = 180 Threshold Value = 70

To Set the Threshold Value

When the scan mode is set to black and white, click the [Tone
Adjustment] button or pull down the Image menu and select [Tone
Adjustment].

Drag the slidebar left or right to adjust the
threshold setting.

0 ==—Tone/Adjustment =———8g

S@\

decrease the entry in the text box, or enter the
value (0~255) directly from the keyboard.

’7 Click the up or down arrow to increase or

I After adjusting the threshold value, you can
] save the setting to a file under a file name and
AllReset | [_load.. | [_Save.. | load the file again whenever you want to use

[(cancel |[[ ok | the setting.

To restore the threshold setting to its default value, click this button.

Click the [OK] button.
The preview image will change to reflect the new settings.

______________9______________
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Auto Tone Correction

When the selected scan mode is Color, you have three options for adjusting the color:
Recommended, ColorSync or None. The default setting is [Recommended].

Recommended:

Reproduces the colors of the scanned item vividly on a computer display. You are
advised to use this mode under normal circumstances.

ColorSync:

Automatically matches the color settings of the scanner, computer display and
color printer. Select this mode when you wish to set the appropriate color profile to
view the colors of the scanned image on the computer display as closely matched
to the original image as possible.

None:

Scans without color correction. Select this mode when you wish to adjust the
colors yourself with the color correction features of Plug-in Module CS-U or
another application program after scanning. This mode is most appropriate for
advanced users.

&

=)

Caution

¢ This function is available only when the scan mode is set to one of the color
modes; not to the grayscale or black and white modes.

¢ The Tone Adjustment menu item, Tone Adjustment button and Auto Tone
Adjustment button are disabled when the ColorSync option is selected.

¢ The previous settings are in effect when Plug-in Module CS-U is started from an
application program that does not display the Plug-in Module CS-U control panel.

Hint

¢ ColorSync™ responds differently to each computer according to the unique
conditions affecting it (type of display used, etc.), which may cause
differences even between computers of the same make and system version.
The tone characteristics of an image scanned with ColorSync™ on one
computer, therefore, may change when processed on another computer.

To Set the Auto Tone Correction

Open the [Image] menu and select [Recommended], [ColorSync] or
[None].

Image

None

Recommended

v ColorSync

Tone adjustment...
Descreen
v Unsharp Mask

High-speed S5can Mode

A check mark will appear beside the selected option, which will take effect.

______________e______________
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Unsharp Mask

The Unsharp Mask function enhances the outlines of an image. When set to On,
this function makes the image outlines appear sharper without changing the
brightness, contrast or color balance, giving it a natural look. It is particularly useful
for scanning images that are slightly out of focus.

The function is on when a check mark appears beside it and off when there is
none. The default value is On.

Caution
\ Q ¢ This setting is not available for the black and white scanning mode.
e If Plug-in Module CS-U is started within an application that hides the

Plug-in Module CS-U control panel, the previous setting will be
maintained.

Operating Procedures

i’ Open the [Image] menu and select [Unsharp Mask].

Image
~ Recommended
ColorSync
None

Tone adjustment...
Descreen
+ Unsharp Mask

High-speed Scan Mode

A check mark will appear beside the Unsharp Mask option in the menu when this
function is set to On. To set it to Off, reselect it. The check mark will disappear.

] Hint
@ ¢ Disable the Unsharp Mask function if the moiré effect is still too strong
even when the Descreen option is on.
¢ When the Unsharp Mask is on, it may take longer to scan.

______________o______________



Descreen

ST EP

3

Select this option if you want Plug-in Module CS-U to conduct moiré reduction to
improve the overall image quality. Moiré are dot patterns that interfere with
processing images for professional use and are usually caused by poor dithering
resulting from scanning images from newspapers, books, magazines, etc.

Caution
\ Q e When you select [Film] in the [Preferences] menu, the Descreen function is

not available.

¢ The Descreen function cannot be switched on for scanning resolutions
higher than 601 dpi.

* The previous setting is enabled for the Descreen function when Plug-in
Module CS-U is opened by a software application operating in the
windowless mode.

Operating Procedures

i’ Open the [Image] menu and select [Descreen].

Image
v Recommended
ColorSync
None

Tone adjustment...
v Descreen
Unsharp Mask

High-speed 5can Mode

A check mark will appear beside the Descreen option in the menu when this function is

set to On. To set it to Off, reselect it. The check mark will disappear.

@‘ Hint
¢ When the Descreen is on, it may take longer to scan.

______________o______________
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High-speed Scan Mode

This function is available when the image source is set to [Platen]. When a check
mark is placed beside this option, scanning can be accomplished faster because the
lamp output data (auto color adjustment data) from the first pass is used for
subsequent passes. The default setting is Off for this function.

Caution
\ é ¢ When you select [Film] from the [Preferences] menu, the High-speed Scan
Mode is not available.

Operating Procedures

i’ Select [High-speed Scan Mode] from the [Image] menu.

Image
v Recommended
ColorSync
None

Tone adjustment...
Descreen
+ Unsharp Mask

v High-speed 5can Mode

Caution
\ g ¢ It may take some time to acquire the lamp output data on the first scan

after the high speed scanning mode is selected. Similarly, the first scan
after Plug-in Module CS-U is started make take some time even when the
high speed scanning mode is selected.

______________o______________
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Saving/Recalling Settings

The scan mode, resolution and preference settings can be saved with a preview
image to a settings file and recalled for future processing. The user may freely
assign a name to the settings file. It is convenient to save frequently used settings
in a file.

Hint
@ ¢ In addition to settings, the settings file may also be used to store preview
images. It is useful to save the preview image with the settings to quickly
grasp to which image the settings apply.

To Save Settings in a Settings File

i’ Open the [Setting File] menu and select [Save].

Setting File

Save..

p Specify the folder where you want to store the file and enter a name for it.

[ Settings | = | = EnglishHD
CanonPl C5=L14.1 5etting || Eject
Save as:
|Can|:|nPI C5-U4.1 Setting |
b Save preview image

| Insert a check mark by clicking this box to have a copy
of the preview image saved with the settings file.

p Click the [Save] button.
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To Recall a Settings File

i’ Open the [Setting File] menu and select [Load].

Setting File

Select the folder where the file is stored and click the name of the file
you want to load.

Cj Settings |~ = EnglishHD
| | canonP1 CS-U4.1 Setting ||
[ ] canonPI CS-U4.1 Setting 2

Cancel

Open

j

P Click the [Open] button.

The file you selected opens and the settings stored in the file are enabled for the
Tone Adjustment settings.

______________9______________
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Scanning Techniques

Matching Scan Resolution to Purpose

Plug-in Module CS-U provides many choices of resolution. The resolution you
choose should depend upon your output device, the intended purpose of the
image, the type of image and your scanner.

It is generally recommended that you scan at a higher resolution than required for
output. This ensures that you obtain the best quality image, which can then be
reduced with an image editing program to suit specific purposes.

Different types of images require different scan settings. However, increases in scan
resolution have a diminishing return after a certain point. For example, a text
image can be scanned at 600 dpi for output to a 600 dpi laser printer, while a color
image should be scanned at 180 dpi to be output to a color bubble jet printer (360
dpi). To output a color or grayscale image to a bubble jet printer, use a resolution
equal to half the resolution of the printer. Set the resolution to 180 dpi, for
example, for output on a 360 dpi printer.

e Scan in Black and White mode if you are scanning line art or other items that are
Black and White with no shades of gray.

e Scan in Black and White mode if you are scanning a text image for conversion to
editable text.

¢ Scan in 8bit Grayscale mode if you are scanning continuous-tone Black and
White photographs, charcoal drawings or originals with shades of gray.

e Scan in 24bit Color mode if you are scanning full-color images, such as
photographs or illustrations.

e |f you are using an OCR (optical character reader) program in Black and White
mode, you are recommended to select a resolution higher than 300 dpi.

______________@______________
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Troubleshooting

Please refer to the following information if you encounter a problem using Plug-in
Module CS-U. For further details, refer to the Troubleshooting item on the CD-
ROM provided with your scanner.

If your problem lies outside the solutions provided below, consult the retail outlet
from which you purchased the software or the closest Canon Customer Support
Help Desk.

Hint
@ ¢ Before you call for assistance, read Quick Start Guide or Troubleshooting.
¢ When you contact one of the help desks listed, you will be asked what
kind of computer is connected with the scanner. Before you call, make
sure you have prepared the information required on the system
information page in the Quick Start Guide.

'S

® Problem: The “Can't use the driver required for a USB device. Search the
Internet for a driver?” dialog displays on a system running
Mac OS 9 (only applicable to Mac OS 9)

Solution:  Scanner software has not been installed. Click the [Cancel] button to
close the dialog. Detach the scanner, and install the required
software from the CanoScan Setup Utility CD-ROM before

s reattaching the scanner. (O Quick Start Guide)

® Problem: Plug-in Module CS-U does not appear as an option on the
menus of a plug-in compatible application program

Solution:  Plug-in Module CS-U is not correctly installed on your hard disk
P drive. Reinstall Plug-in Module CS-U. (O Quick Start Guide)

¢ Problem: The image will not appear even if the Preview button is
clicked on the Plug-in Module CS-U control panel

Solution 1: Make sure the original is set on the document glass correctly

Solution 2: The brightness settings for Plug-in Module CS-U may be set too
high. Try lowering the brightness settings. For details about
brightness setting, see Brightness and Contrast Settings (L p. 43)

Solution 3: The threshold setting for Plug-in Module CS-U may be set too high.
Try lowering the threshold setting. For details about setting the
threshold setting, see Adjusting Threshold Value (L p. 48)



o Problem: Scan button cannot be selected

I Solution 1: A scan cannot be performed if the scan area is set too small (less
than 64 x 64 pixels). Increase the size of the scan area

1Solution 2: A scan cannot be performed unless a scan area is specified. Specify a
scan area

1Solution 3: A scan cannot be performed if the required memory is larger than
the free memory. Change the resolution (I p. 19) or scan area
(O p. 30) until the required memory is lower

¢ Problem: The “Insufficient Memory” error message appears when
scanning

I Solution 1: Select the smallest possible area and rescan

ISolution 2: Lower the resolution and magnification settings for the output
device to the lowest possible values (C1 p. 19)

[1Solution 3: Rescan after closing all the application programs other than the one
used to start Plug-in Module CS-U

1Solution 4: Rescan after you have restarted the application program used to
start Plug-in Module CS-U

I Solution 5: Quit the application program used to start Plug-in Module CS-U and
increase the memory allocated to it. Click the application program
icon once. Then open the [File] menu, choose [Get Info], and choose
[Memory] from the submenu. Increase the memory in the Preferred
Size box to at least 16,000 K.

[1Solution 6: Increase the amount of RAM as required

¢ Problem: The [Image] menu [ColorSync] option cannot be used in
Plug-in Module CS-U

1Solution:  ColorSync is not recognized after Mac OS upgraded to Version 9
after Plug-in Module CS-U was installed onto Mac OS 8.6. Reinstall
Plug-in Module CS-U (0 p. 6)




o Problem: No free disk space message displays when you start a scan

[1Solution:  Since there is insufficient free space on your hard drive, clear non-
essential files to create more space.

¢ Problem: Scanning is taking a long time

[ISolution:  Resolution is set too high. Lower the resolution to the minimum
required settings and rescan.

e

® Problem: Can’t scan with the film adapter unit

1Solution:  Set the film guide correctly on the document glass (platen). See the
user guide for the film adapter unit.

o Problem: Colors in the Preview area are strange

1Solution 1: The original is faded. Try retouching the colors with an image editing
program. (image editing program manual)

I Solution 2: Color balance and brightness are incorrectly set. Reset them.

1Solution 3: The fluorescent lamp inside the scanner is not sufficiently warmed.
Please wait for a minute or two, then perform a preview scan again.

1Solution 4: Calibration slot on the film guide is obstructed. Clear any items or
dust blocking the calibration slot. See the user quide for the film
adapter unit.

¢ Problem: Entire image is whited out (or blackened) when the image
type is set to black and white

[1Solution:  The threshold value is set too low (or high). Increase (decrease) the
threshold value.




o Problem:  Scanning quality is poor

[l Solution 1: Resolution is too low. Raise it and rescan.

1Solution 2: Original is floating off the document glass (platen). Place the original
correctly on the document glass.

[1Solution 3: Document glass or underside of the document cover is dirty. Clean
them.

¢ Problem: Smudges are appearing on glossy color photo scans

"ISolution:  Photos are adhering to the document glass are causing the light to
refract, creating the striped patterns. Shift the photo to a different
position on the document glass or clean the document glass before
rescanning.

¢ Problem: Coloring of the preview image and the printed image is
different

1Solution 1: Insufficient printer toner (ink). Replenish or replace the toner. (printer
manual)

1Solution 2: Color balance or gamma value setting in the printer driver doesn't
match the printer. Manually adjust the settings in the printer driver.
(printer manual)




Error Messages

Error Message

Scanner is not connected.

Connect the scanner.

Scanning unit is locked.
Release the lock switch
and connect the PC to

the scanner again.

1) Cannot complete scan
command. Insufficient
memory (RAM).

2) Memory is insufficient.
Increase the memory
allocated the application.

As image size is large,
it will take long to
complete scanning. Do
you want to continue?

An error has occurred.
Error Code =** Restart
the PC.

|

¢ AC adapter and USB
cable not connected
correctly.

¢ The scanning unit
lock not released.

¢ The scanning unit is
out of order.

e Memory is
insufficient for the
required volume of
the scanned image
data.

¢ You attempted to
scan an image
exceeding 100 MB.

e Scanner or computer
is malfunctioning.

r
}
r
|
|

Response

¢ Use the USB cable to connect
the Macintosh to the scanner
properly and connect the AC
adapter correctly to the
scanner.

e After releasing the lock,
temporarily disconnect the AC
adapter or USB cable.
Reconnect it and restart Plug-
in Module CS-U and click
[Preview].

e Contact your nearest Canon
Customer Support Help
Desk.

¢ Reduce the scan area to the
minimum possible scope and
lower the resolution and
magnification settings for the
output device.

* Close all application programs
other than the one used to
start Plug-in Module CS-U.

® Increase the memory allocated
to the application program
used to start Plug-in Module
CS-U. (O p. 57)

e Click [Cancel] to cancel, or
rescan after lowering the
scanning resolution or
reducing the scanning area.

e Restart the computer.
If the same error code displays
after restarting the computer,
contact the nearest Canon
Customer Support Help
Desk.
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Glossary

Auto Tone Correction

A function that uses brightness/contrast and gamma value settings to
automatically analyze and adjust images.

Bits/Bit Numbers

Each dot of a 1-bit image is assigned either black or white according to the
threshold brightness value, resulting in the image being reproduced in just
those two colors. Each dot of an 8-bit grayscale image can be assigned any one
of 256 tones of gray, ranging from pure white to black. Each dot of a 24-bit
color image can be assigned any one of 16.7 million colors since each of its
color channels (red, green and blue) can be expressed in 256 distinct color tones
(8 bits).

Black and White
An image mode used to reproduce images in two tones only: black and white.
The brightness level at which a dot is determined to be either black or white is
called the threshold value, which can be adjusted. See Threshold Value.

Black Eyedropper Tool
Tool used to the select the darkest portion of an image in the preview area.
Used with the Histogram function to adjust image brightness. When this tool is
clicked on the image, all areas that are darker are set to pure black.

Brightness

The intensity of light in a scanned image. Raising an image’s brightness
increases its overall brilliance, while decreasing it makes it darker.

Color Balance

The function in that enables you to adjust the blend of colors in a color image.
You can adjust the color balance by altering the blend of the red, green and
blue color set or the cyan, magenta, yellow and black color set.

Color Channel

Any one of the red, green or blue elements of a color image. Since color images
are assigned 8 bits per pixel for each of the red, green and blue channels, each
pixel is assigned 24 bits of data. The master channel is the composite of these
three channels. In the Histogram and Tone Curve image adjustment functions,
each channel can be separately or collectively adjusted.
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Color

An image mode that scans an image as red, green and blue (RGB) light and can
reproduce each one of these three colors in 256 distinct tones (8 bits). Since
256 x 256 x 256 = approximately 16.7 million, this many color tones are
possible in this mode.

ColorSync

A color management system for Macintosh computers. Automatically
compensates for color differences between scanners, monitors and printers.
ColorSync requires that a color profile file be included for your specific monitor
or printer.

Contrast

The difference between light and dark areas of a scanned image. Raising the
contrast makes individual components of an image stand out more while
lowering it softens the image’s overall appearance.

Dot

The basic element used to reproduce images. Images are reproduced as
columns and rows of dots. A scanner’s resolution is the measure of the number
of dots it can read and reproduce per inch (dpi).

DPI

Dots per inch. An expression of monitor and printer resolution. Measured as the
number of dots per horizontal inch on monitors and the number of dots that
can be printed by a printer in an inch. See also Pixel, Optical Resolution and
Resolution.

Gamma Value

A function for adjusting the overall brightness of an image. A gamma value is
the mathematical expression of how brightness data is converted from a
scanner (the input) to a monitor or printer (the output). With 1 as the base
value, a gamma value less than 1 makes an image darker, while a higher value
makes it brighter. The brightness handling characteristics of monitors vary
between manufacturers and models. A monitor's gamma value explains the
degree to which its output (what you see on the screen) varies from the input
value.
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Grayscale

An image mode that scans only the brightness data of an image and reproduces
the image in white, black and 254 shades of gray (256 tones or 8 bits).

Histogram

A graph indicating the distribution of brightness data in an image. A dot is
assigned a brightness value ranging from 0 (shadows) to 255 (highlights). The
histogram shows how much image data there is at each brightness value.
Adjusting the histogram changes the image contrast.

Image File

Images are expressed as collections of dots with varying color and brightness
values that are digitized in particular formats for processing by a computer. At
the most basic level, an image file contains bitmap information, which is the
color information for each dot in each column and row of an image. The
various file formats (TIFF, BMP, etc.) use different methods of storing and
recalling this information.

Magnification
An expression of the relationship between the scanning resolution and the

output resolution stated as a percentage. If the output resolution is set to 720
dpi and the scanning resolution to 360 dpi, then the magnification rate is 50%.

Moiré
The patterns or lines created by overlapping dots in an image. This
phenomenon is found when photographs or pictures are scanned from books

and magazines at low resolutions. The Descreen function helps to eliminate
moiré patterns.

Optical Resolution

An expression of the volume of data per inch (dpi) that can be sampled by a
scanner.
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Pixel
An abbreviation of picture element, the smallest element on a monitor screen.

Plug-in Software
A program that extends the functionality of an application program. Plug-in

Module CS-U is a driver plug-in that adds scanning capabilities to programs
such as CanoScan Toolbox and PhotoStudio 2000.

Preview Area
Area at the right of the Plug-in Module CS-U window used to display preview
images. Clicking the [Preview] button causes the scanner to scan its platen and
reproduce the image in the preview area. Please note, however, that preview
images do not get downloaded to the application program in use.

Preview Scan

A low-resolution, trial scan of an object. The image shown in the preview area
can be used to adjust the scan area, brightness and color balance before
initiating the final scan.

Remove Dust and Scratches

This function is available with a Film Adapter Unit FAU-S13 equipped CanoScan
D2400U. It utilizes the properties of infrared light to detect small flecks of dirt
or scratches on film and retouches them.

Resolution

The density of the dots used to express an image. Image fineness or coarseness
is expressed as the number of dots per inch (dpi). See also DPI.

RGB

A color set of red, green and blue: the three primary colors of light. The scanner
picks up light reflected off objects with its red, green and blue sensors. Color
printers output color using the complements to the RGB color set, which are
cyan, magenta, yellow and black (CMYK). Cyan, magenta and yellow are called
the three secondary colors.
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Scan Mode

Any one of the various methods used to reproduce image data. Scan modes are

distinguished by the number of bits used to describe each pixel. Plug-in Module

CS-U features the following scan modes.

¢ 24 bit Color: assigns 8 bits of data for each color channel (RGB) in each pixel.
Each pixel is therefore assigned 24 bits.

¢ 42/48 bitColor: While the Color mode scans at 8 bits per RGB channel, this
mode scans at 14 or 16 bits per channel to achieve a particularly high-quality
image. Each pixel is expressed with 42 or 48 bits of data.

¢ 8 bit Grayscale: assigns 8 bits of data to its single color channel. Each pixel is
therefore assigned 8 bits.

¢ 14/16 bit Grayscale: While the Grayscale mode scans at 8 bits, this mode
scans at 14 or 16 bits to achieve a particularly high-quality image. Each pixel is
expressed with 14 or 16 bits of data.

¢ Black and White: assigns 1 bit of data to each pixel.

Scanning

The process of using a scanner to read image data. Scanned data is sent to the
computer as image data.

Shadows
The darkest portions of an image scanned in a color or grayscale image mode.

Threshold Value

The dividing value at which a pixel is determined to be either black or white
when the image is reproduced as a black and white image. The higher the
threshold, the darker the image. The lower the threshold, the brighter the
image.

Tone Curve

A function used to adjust image brightness. The tone curve (or gamma curve) is
a graphic representation of the relationship of the input from the scanner to the
output to the monitor or printer.

Unsharp Mask

A function that sharpens image outlines. Makes an image appear naturally
sharper without changing the brightness, contrast or color balance.

White Eyedropper Tool

Tool used to the select the brightest portion of an image in the preview area.
Used with the Histogram function to adjust image brightness. When this tool is
clicked on the image, all areas that are brighter are set to pure white.
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